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Welcome!

This guide is for all VA designers who have intermediate
experience in Adobe Indesign and lllustrator.

This guide is also perfect for owners and agencies who want to
train their VAs to customize our templates for their brand. And
we also have a corresponding course for design VAs, since we
have courses on everything we do.

In this guide, you will learn the CoachYu branding methodology
as well as how we work, skin, and redesign our guides. You will also learn to prepare
presentation decks and our course creation process, as it relates to design.

Professional branding immediately gives people the impression that you're an
established, confident, and trustworthy company. That is why you need to learn these
basic principles before you start designing.

We are incredibly grateful that you have chosen us to help your VAs develop these

important design skills and look forward to your success as you seek to develop a
professional brand!

Dennic Yu

Host of the CoachYu Show
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https://academy.blitzmetrics.com/courses/master-design-course/

The CoachYu Logo

This is our logo.

Our logo is simple, clean, and crisp. It easily translates through most forms of media
that we use. Keep in mind that simplicity is key when working with our logo, the design
should not create conflict with the logo’s design style. It is important to note that when
working with our logo, it is a must that we work on it through Illustrator and not
photoshop because vectors preserve scalability and quality.

Logotype
This is what we use for most of our materials. Make sure that the text and fine lines
are still legible when the logo design is scaled down.

COACHYU

How we use the logo

We usually add the logo to the lower left side of our printed materials and guides. Logo
use in our videos can vary from this format. Be watchful for overuse of the logo, it
should be enough for the logo to show up once or twice per page unless it is needed to
occur more (ie. diagrams that need our logo to show up multiple times).

Also, be aware that the logotype is not to be used heavily in our designs.
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Baosic Paletta . -

Using color to focus content

Color Palette

We have a color we call CoachYu Blue, our other colors stem from that particular
hue of blue. Lighter colors are best suited for design purposes when other content,
such as images or words, need to be the focal point.
This isn't to say we can't stray away from the palette. Just be sure to take function over
form. The boxes that have our signature bolt are part of the basic palette.

Authoritative

#0EETBE

Rich
Energetic /
Vibrant

F11518

FHAICIE

#222323
5

COACHYU

CoachYu Blue,
the swatch with
the bolt icon, is
our main hue of
blue. Used
mostly in our

8 logo, itis also

good for
headers and
sub-headers
when used
sparingly.
#00AEEF is
used for our
hyperlink style.

#222323 is our
main text color.
We refrain from
using actual
black and prefer
grays because it
is less straining
to the reader’s
eyes. We have
a lot of content
and we have to
make sure we
get and retain
the reader’s
attention.
Lessening the
harshness of the
text color helps
with that. The
lightest colors in
our pallette work
great with the
two darkest
grays when
used

sparingly.

Our yellow palette
is good for adding
contrast to our
guides. It is great
for adding
splashes of color to
compliment our
blues. Not great for
light font styles
against a white
background though
it may work when
used with a heavy
font style and large
font size.

Reds are the
trickiest color to
use in our palette.
Mainly used for
catching attention
or as a warning
system. Adding a
splash of red to a
note makes it
seem more
important. Red isn’t
recommended for
use as the main
color scheme since
it clashes with our
CoachYu Blue
color palette. It is
also good for
highlighting text.

HODIC25

HEOID2A

HEEIE2D

* Here’s an
example of a note
that uses red to
add emphasis.

Top and middle
green works great
against a white
background.

It can be used for
headers and/or
sub-headers. Green
is a good alternative
to a blue color
scheme with
yellow/orange as

its complimentary
color.

#D7DF23 green is
not great for

light fonts against a
white background.

#HGIVFIC

Beige is good for
strokes on paths
and/or lines. ltis
great as a base color
for shadows. You
can play with the
opacity to serve your
needs.

#TI6ASE
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Gradients and Color Combinations

Gradients give depth to our images. By using gradients, we add an additional
dimension to an otherwise plain design without contradicting the clean design theme.
You can mix and match colors from our palette however you see fit, just remember
that subtlety is key.

Subtle progression

Make sure that the progression of the tint is slow and subtle from dark to light, left to
right. Jarring color changes and combinations look weird and are reminiscent of 90’s
WordArt.

Basic combinations
Here are some basic combinations for both light and dark themes that you can use.

COACHYU COACHYU

COACHYU COACHYU C ACH COACHYU
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How To Get Hex Codes of A Logo

1. Go to Canva palette generator and upload the logo.

Upload an iniage

2. Select the logo from your computer.
3. After uploading the logo, the HEX Codes will be generated automatically.

The Topic Wheel goes from the outside (WHY) to the middle
(HOW) to the i '

Pearl Bush Ming Fire Bush Flamingo
#EGDBCF #327871 #EBARZZ #EE5321
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https://www.canva.com/colors/color-palette-generator/

Typography and Margins

This is the Main Header. Myriad Pro, Bold, 16pt.

*Motes use a red asterisk.

We use the font ‘Myriad Pro’ as our main Typeface
The typeface goes well with our CoachYu logotype font. We need to minimize the number
of fonts used in our guides. Less font variation = more consistency / more professional look.

This is a Sub-header, the font used is ‘Myriad Pro, 14pt font size. 14pt Leading

This is the main content text. The font used is ‘Myriad Pro’, 12pt font size.The leading is
14pt. Sometimes we use an italic version, for example, “Quotes such as this one, which
uses Myriad Pro Italic, 12pt, bold. Using italicized styles make the sentence seem more
important.”

We always use left-aligned text. We also set the Kerning to be Optical and make sure that
we don't or at least, lessen breaking words midword.
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Here’s an example of how we add lists to our guides
1. Make sure listed items end with a period.
2. When dealing with a paragraph as the list item, make sure that the text is indented
to be after the number.
a. Sub-lists use letters.
l.  Further sub-lists use Roman numerals.
3. When listing items that are in no particular order, we use a bulleted list..
e Like this.
e And this.
e And this.

When creating a hyperlink, make sure we use the CoachYu link style

Let’s use the link to the Design Style Guide folder in the Team Drive as an example. You
can click on the link here.
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The Cover Page

The cover page and first impressions.

The cover page is the first thing the client or customer sees, having a professional

looking cover creates a good first impression and further legitimizes everything within

the guide even before they flip the pages.

Thi backgrourd phabs This b the guida's dta.
should be 3 high Tha cokars should ba
authornithy phictograph conkrzsted anough to
of the Fgunersiad and b readable evan with
should notlookbo busy a badoround Image
and ditracting. behind It. Tra
shiould not oover the
The backgrourd must subjects facd,
Py s corirst with the
baectin tha foreground. Tha fomt waed k& Myrad
R A N D o }
rme®! COURS E
of thasa kems should e Some quides ave a
ignhed o thecantar. WHD ARKE YOUR BEST CUSTOMERSE m':nﬁmm'
Semioond, 2pr
Add tha gquide’s badge
wtha -m?;r mEge g
Usaa high-quality head
shat o the figurhead
for tha cowar.
E Dennis Yu
Dannis s Ms defowe ' = =
Sgurehand far s [ Chief Executive Officer
guides. Only changa
thiswhantha quida & F i
Fanded over 1o a new J
B s,

COACH 7 )

bilz_biand_onalys’s_course_v14_L10a8_0TiG

This tg shows tha HHa of the quida and 'z numbsar iRz
12 Meules. This will ba furthar dEcusad In tha Pagas
Tempiara pagaon this guide.

Shicre thee Agurete s name Iprad Pro, SamiBoid, 2000
wkhtral B pradPro, Semiolt, Mo belowt

Thits st thae file version. This shesld absags be updated
acenmding to thaquide's cumrant varzion.

For Google Documents, you can use "Wrap Text" on the text wrapping, and "Fix position on
page" on the Position section to align the image properly.

COACHYU
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Google File Stream and the CoachYu
Graphics folder

What is Google File Stream?

It is a free service from Google which allows you to access files in your Drive from your
computer, freeing up space in your disk drive and network bandwidth. Because Drive
files are stored in the cloud, any changes you or your collaborators make are
automatically updated everywhere.

You can also make Drive files available for offline access. These cached files sync back
to the cloud when you're online, so the latest version is available on all your devices.

Download Google File Stream here.

o Local Disk (D:)
o 0ogle Drive File Stream ((G:)

*You can view files from your computer as if it was stored in a physical drive locally.

The CoachYu Graphics folder
We have our images in a single folder called the CoachYu Graphics folder. We have it
all in one place so we don't have any problems finding files and removing duplicates.

NO. DUPLICATE. FILES.

A significant amount of images that we have are reused throughout our guides, that's why
we only have one version for each file that we use often. This eliminates duplicates and
different versions of an image in our guides. When you're going to work on an image,
make sure there isn’t an existing one beforehand

i:or example: Image A is used and linked to both Guide B and Guide C. When we edit
Image A, it is automatically updated in both Guide B and Guide C.

Vector images and why they matter

Vector graphics are used throughout our guides. A vector graphic is made up of points,
lines, and curves that are based upon mathematical equations, rather than solid colored
square pixels.

We only use vector graphics for our guides, we want to preserve quality in the images
because we export guides as PDFs. This way, when people zoom-in to the PDF, they will
never encounter pixelation with the exemption of raster images like photos.

Also, when we use photos, we use a large resolution to reduce pixelation.
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The Master Guide, Master Presentation, and
Checklist Architecture

The Master Guide
As the name implies, this guide is the ‘master’ file from which all guides are compiled. The
Master Guide must always contain the most recent version of our guides.

The Master Presentation

The Master Presentation is a direct counterpart of the Master Guide. It is a presentation
version of the Master Guide. Every guide we have has a presentation version which is
compiled in this guide.

The Checklist Architecture

The Checklist Architecture is a compilation of checklists found throughout all guides.
Slides in this file are compiled in the Master Guide. The Checklist Architecture has a
presentation version which is compiled in the Master Presentation.

What is a presentation version?

As the name implies, presentation versions are used in slides for keynote speeches and
presentations. The slides should be less-detailed but must remain understandable
enough with one glance. It should not be saturated with text.

Summary

e Guides contain one-pagers/checklists.

One-pagers/checklists are compiled in the Checklist Architecture.

Guides are compiled in the Master Guide.

Guides, the Master Guide, and the Checklist Architecture have presentation
versions.
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Diagram: Master Library

The ‘'sample’ guide has
one-pagers/checklists
that are compiled in the
Checklist Architecture.
The entire sample guide Master
(with the exception of the Guide
cover page and table of
contents) is compiled in
the Master Guide, along
with its perspective
checklists.

Master
Presentation

The 'sample’ presentation
are mainly diagrams, and
videos. It has lesser texts

R compared to the Master
One-pagers/checklists in Guide

the Checklist Architecture
are found in the Master
Guide separated into
their respective modules/
sections.

Checklist —
Architecture

- One-pagers/
checklists in the
Checklist Architecture
Presentation Version
are found in the
Master Presentation
separated into their

L  / v respective modules/
sections.

Sample e
Sample | :
Guide B Presentation

Presentation
A

Every guide has a
presentation version, which
is a less-detailed version of
the original guide.
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Master Page templates and Section Prefixes

A template for every guide.
We have a template for every guide that is based off our 18
Modules, seen below.

BUSINESS AMPLIFICATION Y OPTIMIZATION
PACKAGES
STUDENT PERSONAL CONTENT BRAND PROJECT PEOPLE
TRAINING BRANDING FACTORY ANALYSIS MANAGEMENT / MANAGEMENT
PARTNER

MARKETING ADS
PROCESS COURSE BUILDER /D H AUTOMATION AUTOMATION

The first module in the diagram is the Plumbing module. In our templates in the Pages
tab, it is found as 1-Plumbing.

Important: Every guide should use its respective template. This not only reduces
errors in the future, but also helps in tracking.

Overview guides.

If you notice, there are templates called A-Business: 1-6,
B-Specialist: 1-6, and C-Partner: 1-6. These represent the 3
guides that are overviews of the 6 guides within themselves.

[None]
A-Business: 1-6
1-Plumbing

The 3 overview guides are:
Social Amplification Engine. It is an overview from Plumbing
to Optimization.

2-Goals
3-Content

4 Targeting
Digital Marketing Training System. It is an overview from
9 Triangles to People Management.

5-Amplificabon
& Optimization

The Partner overview guide is yet unfinished but will be
labeled according to our template. It is an overview from
Course Builder to Events Management.

B-Speqalist: 1-6

7-9 Triangles
8-Personal Branding
SInfluence Generator
10-Brand Analysis
11-Project Managemeant
12-People Management

C-Partner: 1-6

13-Course Builder
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How To Apply Our Templates To Pages

Here’s how to make your job easier.
If you're working on a new guide or updating an old one which doesn’t use our template,
these steps will help you migrate into a much easier and efficient workflow.

How to apply our templates to pages.

Step 1: Select the pages from the Pages tab which you want to apply the template. See
below.

Step 2: Right-click on your selected pages and

select Apply Master to Pages. See below.

Insert Pages...

[None]

A-Master

Move Pages...
Duplicate Spread
Delete Spread

Print Spread...

Apply Master to Pages...
Override All Master Page ltems Ctrl+ Alt+Shift+L

Create Alternate Layout...
Numbering & Section Options...

+  Allow Document Pages to Shuffle
~  Allow Selected Spread to Shuffle

Page Attributes »

View Pages ]

Panel Options...

Step 3: On the Apply Master: dropdown menu, select which
template you would like to apply to the pages. See below.

On the To Pages: menu, you can see which pages are going to be
affected by your changes.

Click OK and you're done applying the template.

Apply Master

aoply Master:  1-Plumbing

To Pages: DSG-1-DSG-4 ——
| Cancel )
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Prefixes and Page Numbering

Let’s label our pages.

Like in the last tutorial, if you're working on a new guide or updating an old one which
doesn't use our template, these steps will help you label the pages correctly. This will
help you, as a designer working with InDesign to track your pages.

How to label your pages.
Step 1: Select the pages from the Pages tab which you want to
label. See right.

- .! !ﬁ*

Important: Do not include the Table of Contents pages when
selecting pages to edit.

Step 2: Right-click on your selected pages and select Numbering &
Section Options. See below.

Apply Master to Pages...
Override All Master Page ltems Ctrl+ Alt+Shift+L

==
3
i

Create Alternate Layout...
Numbering & Section Options...

»"  Allow Document Pages to Shuffle
»  Allow Selected Spread to Shuffle

Page Attributes »
Important: Do not select the Start Page Numbering at: option if you are not working on
the Master Presentation, Master Guide or Checklist Architecture.
The reason being that if you are working on the guides mentioned, and the pages you are
editing are in the middle, clicking on the said option will create another page 1. This in

turn will mess up the succeeding page numbers in the footer and the Table of Contents.

Step 3: To understand our numbering convention, we will use Targeting, the fourth
module in our 18 Modules as an example. See below.

A'is the section in which the pages you selected are a part of. A being the Business
Packages.

4 is the number in the 18 Modules that the pages are a part of. Since Targeting is the
fourth module, we use 4.
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A-Jusiness: 1-6

1-Plumbing

2-Gaals

3-Content

4-Targeting

Step 4: Therefore we write Ad- (the - is used as a spacer between the prefix and the actual
page number) on the Section Prefix.

Select Automatic Page Numbering and click OK. Congratulations, you just eliminated
headaches from trying to find your slides in the Master Presentation and similar guides.
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Start Saction

© Automatic Page Numbering

Cancel

(1 start Page Mumbering 2t 1

Pzge Numbenng

Section Prefo:

Section Marker:

| Include Prefix when Numbering Pages

Document Chapter Numbenng
Style: 1, 2, 3. 4.
© Automatic Chapter Numbering

{3 start Chapter Numbering at: | 1

Book Name: N/&
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Page Numbering Codes

Here’s how to make your job easier.

Using page codes in your InDesign file will help you in tracking your files, especially when
you're adding them to the Master Presentation, Master Guide, and Checklist Architecture

which have a lot of pages.

Here are the codes for the page numbering.

Page Code
A-Bus-

A1-

A2-

A3-

A4-

A5-

A6-

B-Stu-
B7-
B8-
B9-
B10-
B11-
B12-

C-Prt-
C13-
C14-
C15-
c16-
C17-
C18-

COACHYU

Master Template
A-Business: 1-6
1-Plumbing

2-Goals

3-Content

4-Targeting
5-Amplification
6-Optimization

B-Student: 1-6

7-9 Triangles
8-Personal Branding
9-Content Factory
10-Brand Analysis
11-Project Management
12-People Management

C-Partner: 1-6
13-Course Builder
14-Dashboard

Course Name

Social Amplification Engine
Digital Plumbing

Goals Analytics Checklist
Content Marketing
Dollar A Day

Amplification Checklist
Optimization Guide

Digital Marketing Training System
Business Framework Triangles
Personal Branding

Content Factory

Brand Analysis

Success Tracker/Asset Tracker
Meetings Checklist

N/A
Course Builder
Dashboards

15-Marketing AutomationN/A

16-Training Systems
17-Ads Automation
18-Events Management

X-Operations Tracker

N/A
N/A
Events Checklist

Operations Tracker
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The example below shows the Page Codes applied to pages. Ignore the right- most
numbers, those just show the actual page numbers that InDesign adds to our template.

=
A L

l1 --I-

=
I
P
[y

' ‘ -.:-

l‘

Tm
ol
=y
¥}

Al
]

;:I l‘ -.:-

e i

"

H‘

1
=

| -

COACHYU

D5G-40

[Mene]

A-Business: 1-6

1-Plumbsing

-Goalk

3-Conlent

#Tangeting

&-armplficabon

& Opbrization

B-Shedent: 1-6

-8 Trangles

S-Personal Brandmg

S Influence Generator

10-Brand Analysis

11-Propact Managamant

12-Papple Man agamant

C-Partner: 1-6

13-Coursa Builder

14-Dashboard

15 Marketing Automaton

16 Training Systems

17-Ads Automabon

16-Ewverts Marmsgamsnl

¥-0One Pager

{-Operatons Tracker

¥-Design Shyle Guide

The screenshot below
shows the Master
Templates that we
have ready to be
applied to your old
guides.
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How To Transfer INDD Pages To Another File

Why do we transfer INDD pages to another INDD file?

Transferring pages from one INDD to another file preserves the editing capabilities of the
objects in that page. When you edit the original file (where you're transferring from) it also
updates the objects in the new file. This is much more efficient than copying and pasting one
page at a time.

How to transfer INDD pages to another file.

Step 1: Open your two files in InDesign, one file where you're going to be moving
pages from and one where you're going to be moving the pages to. In this example
we'll be moving pages from the Checklist Architecture to the Master Presentation.
Select the Checklist Architecture file.

B B iz

bilitz_checkist architecture w7.2

Step 2: Click on the Pages panel in the upper-right corner of the artboard and select
the pages you want to transfer.

Important: Never import PDF pages to the INDD file.
Importing PDF pages into an INDD file removes all interactive objects from the file.
Think of it as importing a JPG image into a PDF, there would be no clickable links, no
tickable checkboxes, and no video.
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Step 3: With the pages selected, right-click on the pages panel. Click on Move Page

Insert Pages...
Move Pages...
Duplicate Spreads
Delete Spreads...

Step 4: Click on the Move to: dropdown menu and select the file you're going to
move pages to. In this case, it's the Master Presentation.

Move Pages: Letter V:1-Letter V:5
ation: After Page

Move to: Current Document

| Secret_Intemal_Master_Presentation_vB.9_2019_0815.indd
-qul'\-l-l'l!_\.il!-lli Pl e |

Step 5: Choose your destination (where you want to insert the pages) and Click OK.
Save your files and you're done.

Move Pages: Letter V:l-Letter Vi5

Destination: After Page

Move to: Secret Intemal Maste...
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How To Partially Export A Google Document
To A PDF

1. Press "Ctrl + P", then it will prompt to print the document.
2. Input the following:
e Destination: Save as PDF.
e Pages: Custom, then input the pages. For this example, it's 1-30 (excluding

page 31, Pending Process Update).
3. Hit Save.

There is a glitch with a Google Document when a user exports the file. The PDF shows
a white space on the top of the cover. This happens when a suggestion comment or an
addition using “Suggesting Mode” is on the first page.

Simply move the suggestion to the next page or ask for a process developer, or an
operations specialist to resolve the comment. Do not resolve it yourself.

TRIANGLES

-

LEVEL 1
Specialist
Guide

The Caver on the Master Specialist
Exported PDF Guide Document

COACHYU
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Creating One-pagers

What are One-pagers?

One-pagers contain a checklist of the steps that need to be taken to complete a task. It can be
printed out so people can check off items as they complete the steps. All one-pagers and
checklists are compiled in the Checklist Architecture.

Items in the checklist should be concise and easy to understand with no room to be
misunderstood. We used the Managing Public Figure Pages one-pager as an example as a
template to help you understand what a one-pager should look like. We have the example
below.

Download the One-pager Template here.

The Header contains

thetitle orname of the
e s MANAGING PUBLIC FIGURE PAGES
descriptive of thetask to
Ibe accomiplished.
Each task name should
have a superscript that
shows its rmr_nberil_i the p D Engagement Management
.}ﬁ.c:: h%r::‘%tm;ll._txary. and use a public figure page to boost your personal brand, Shares: Superscripts in red
to hat paricuiar tak's []-Like all shared posts.™ et Lty ot
training. Prerequisites: |:| - Comment on the sharad post saying “thanks for sharingl™™ A do not have training
. I:‘ 1. Understand the prerequisites for building a page. yat. Cplorhg_me_\‘n red
x:;réﬁ#:;;:wd A. Be willing to produce video. Comments: helps in tracking items.
have a superscript that B. Have something to teach. Positive Comments
links to the 1,000 C. Have a long-term mindset. |:| « If from a public figure, ask if we could quote them on that.
g'g:f::_?::m::‘x DI.GM the same profile picture across all platforms. Else, reply with a “thank you note”, or appropriate rasponse.®
doesn't have training 3. Goto Facebook Page Creator and start creating your page.™ |:|‘l(eeplracl< of positive, high authority comments — add to
yet, D 4. Connect to Business Manager.” content library.?
[[]5. Create a Facebook ad account.
D &, Start boosting posts on Facebook using your Ad account.™ Negative Comiments
D 7. Plumbing- Set up tracking. - Hide all negative comments.™
|:| 8. Content: What to post. = Block persistent nagative commants from same person.™

Sub tasks are indented
and should have

superscripts if they are = (reate a Content Library: Likes/Reactions
available. ["]+ Use Mention, Google Alerts, CrowdTangle, and Brand24.% []«Imwite peaple to like the page.™
Content Library Template
. . Content Library updating:
g:’g{;_t:t“l:‘::s:_f:m ]+ ongoing Page Maintanance: 10 min per day by Virtual Assistant. [+ Adding positive mentions. =
a check box thatis [ Merating on “Greatest Hits"* Badges are added to
clickable. Makesure ™= [ | Inbox Management™ []- Adding videos to your “Current Videos” section as you upload the ends of files to shaw
me?fnt?ec:‘ag‘lmsﬂe «Respond with a canned message or if you know how to help to Youtube, = the reader what badge
;‘;‘om;;cto 95: ’ that persan, assist tham as neaded. m === theyl attain after
3 2 finishing the checklist

and passing the quizin
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Interactive files and Basecamp

Why do we use interactive files?

Every guide or one-pager we create is handed out to clients and customers. We give them the
option to learn and do the training themselves, that is why we leave them links, check boxes,
videos, etc. to help them out. Interactive files do just that.

Think of it this way, when you see a hyperlink in your standard - every day book, it would be
impossible (obviously) to click on it. You would have to type the URL into your browser, and that is
incredibly time consuming. Having a PDF eBook on the other hand, allows you to click on that link.

Important: Always save your files as Adobe PDF (Interactive) when you export your INDD file to
PDF.

Save as type: | Adobe PDF (Interactive)

Basecamp is where we live
We use Basecamp to communicate with the team and track tasks. Updates on the threads should
be often and detailed.

Basecamp is a great tool for communication, but not very good for storing files. It only allows for a
few gigabytes of total storage of uploaded files, when we used up our allowed storage, we would
have to delete older files that were uploaded. This is a very tedious task to do since we update
threads very often. A very good alternative is to use Google File Stream instead.

We copy the link from our team drive (from your computer), then right- click on the file we want to
add to Basecamp, then click on Copy link to Clipboard. You can now add that URL to the thread
without using up storage space in Basecamp.

& Open with Google Drive
L. Copy linkto clipboard
~ L. Share with Google Drive

Y

g .'l'r.i.angl:ﬂ]: 'Y Drive File Stream
In Basecamp, you can paste your copied link to the comment you're adding

B I S & & 1 M = <> i=

[Enter a URL...
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6 Types of Visual Content
We design 6 types of visual content.
We design for Memes, One Minute Videos, Instant Articles, Infographics, Lead Ads, and

Conversion Videos. Check this link to see the details for each type in order to gain an
understanding on how we should be designing for each of them.

B Awareness I Consideration I Conversion

One Minute Videos

Instant Articles Infographics

Lead Ads Video Conversion Ads

COACHYU
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Course Creation Process

Build a landing page (Who it’s for (and not for),
Why it's valuable, Process after purchasing).
Include the guide download upon purchase.

Create a Basecamp Project for each
full-blown course,

Make a product and order form in IFS. (Do not
do this if you have not taken the Infusionsoft
Basics Course).

Create a list of lessons and topics.

Make course tags in Infusionsoft and

Film or collecticourse videos. add to the Academy. (Level 4+ only).

Edit the videos (Upload to Wistia) Post from public figure page.

Transcribe Videos (If you use FancyHands,
follow the correct process)

Boost and promote the course to drive
awareness.

Create a guide from the transcription of

3 Create a fulfillment campaign in Infusionsoft.
the videos.

Load the videos (Wistia Videos, not YouTube)
and course content into the Academy. This
includes a quiz and badge upon completion.
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Course Creation Checklist One-Pager

COACHYU

COURSE CREATION
CHECKLIST

B O

ONE-PAGER

[J This course has an introduction and a title.

[J It has a one-pager (checklist/cheat-sheet).

[J It has a cover photo.

[J It has the current guide available after purchase.

[J The course has a quiz (MICRO courses should have 10 questions and standard
courses should have 20 questions).

[J It has a badge loaded with the correct requirements.

[J It has a landing page with a CTA checkout button that links to the shopping
cart/order form.

[J It has lessons/topics that contain edited videos with no RAW mistakes and are
embedded through Wista.

[J The course is set up with Dynamic Conversion tracking.

[J It has associated auto-enroll tags associated with Infusionsoft.

[J There is no content with previous specialists/VA's who are not with us anymore.

[J Has an active fulfillment campaign in Infusionsoft.

AFTER PUBLISHING
[J The course has been promoted on Social Media for $1/day for 14 days.
[J The course is in our Course Catalog, Asset Tracker, Project Tracker tabs (we want
all of these in one document)
[J Update the Course Tracker in the Asset Tracker to document and track all
course assets.
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Components of a Course

Introduction with Title

1.
2.

3.

4.

This course has an introduction with expectations of the courseware and a title.

“Why <guide topic>". You need people to understand why Personal Branding or the
topic is important.

The strategy behind the checklist. How it fits with the other checklists (no checklist
stands alone, since they're all linked together).

A few sentences from the guide owner (whoever is “adopting” this guide as the resident
expert/ curator/ figurehead).

One Pager (Cheat Sheet)

1.
2.

3.

4.

The checklist boiled down to just one page with checklists items that have check boxes.
Summarize the content to a single page of 5 primary items. Each item will have one or
more steps.

Show overall time summary as well as section times: how much time for a trained
analyst to complete the checklist once.

Show a single number for Training Time, which is the number of hours to learn the
strategic concepts and tactical knowledge necessary to be able to implement (not the
implementation time).

Full Checklist with Steps (optional)

1.

2.
3.

If the listing takes 3-4 pages to list out the 5 primary checklist items and step-level
detail, then include this section.

Show time at the step level, aggregated to the item level and then overall checklist level.
Ask the checklist owner to supply what is missing.

Structure Your Course with Video Topics

1.

One pager showing the Introductory Video (a live video which should be on the landing
page for this checklist, and optional accompanying videos (some made by us and most
to be made by LDS Business College team).
Three categories of videos:
e Livevideo is a person talking in front of a camera (used for the introductory
video).
e How-To screenshare is a Go-To-Meeting desktop recording in our YouTube
channel showing click-by-click how to do something.
e Expert Interview is a partner explaining one of the key concepts.
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5 Types of Content

As we are tagging content with various tags for level, topic, related task, and so forth--
make sure to have a column (not a tag on what level access the content is for:

Public -- anyone can see it, like on a public figure page or blog.
Gated (free) -- they must be logged in to our system.

Gated (course specific) -- they must be customers of that course.
Gated (Office Hours) -- anyone with a current, valid membership.
Internal -- CoachYu team members only.

Work-in-progress content is internal, by definition, since it's not ready for publishing.
As we are tagging content with various tags for level, topic, related task, and so forth.

Google Doc versions of our checklist guides are INTERNAL GUIDES in finer detail so
that internal resources can execute these steps.

The differences with the internal guides (besides living in Google Docs instead of in
these PDFs) is that internal users (our team members):

Have access to specific systems that we've integrated to help us speed up the work--
increasingly so, because we are trying to automate the whole thing. Of course,
businesses who buy a $7 guide don't get access to these, except the dashboard for
metrics.

Task verification and QA-- of course, we don't provide human support to non-clients.
And given that they're not working for us, they don't have to agree to or abide by our
standards. But we can provide automated follow-up in Infusionsoft and the dashboard
to nudge non- clients along for the DIY path.

Payment and job progression-- to get paid per hour/task based on level, as in our
leveling system. This is the analyst track-- running parallel to the business track-- not what
a busy business owner would want to understand nor spend sufficient time to do
themselves.

So it's okay to have PURCHASABLE GUIDES and INTERNAL GUIDES, so long as we
understand that the former has step-by-step instructions to accomplish the tasks via
systems they have access to without support from us. The internal guides should be built
from the purchasable guides-- not the other way around.
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Checklist

@ Course

e Every task, checklist, and course should have a web page explaining it.
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Design Templates

Advanced template for co-branded Fiverr and CoachYu
https://drive.google.com/open?id=19NnHBIR -eeTsF4vvkpi3vSrcop HeSF

V1.1 on blitz PBM template... added page numbers then fixed some of the pages for
easier editing.

https://drive.google.com/drive/folders/1]f59BhsTCORgr
uC89w5FCmq9sxNvM9b?usp=sharing

Video on editing the Indesign file
https://www.loom.com/share/d420006085084fb0ab439619923187ee Basic template
here

https://drive.google.com/drive/folders/1qyRdo7095xAiEbV-
bYutsIS4XDgay9QV?usp=sharing

Video on editing the Indesign file

https://www.loom.com/share/d420006085084fb0ab439619923187ee

"DESIGN
TEMPLATES

STILL IMABES FOR PROMOTING WEBINARS,
EVENTS, PROMOS, AND INTERVIEWS

oonohyu deskgn B mpites_v S 301023

DESIGN TEMPLATES
Still images for promoting webinars, events, promos and interviews
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https://drive.google.com/open?id=19NnHBiR_-eeTsF4vvkpi3vSrcop_HeSF
https://drive.google.com/open?id=19NnHBiR_-eeTsF4vvkpi3vSrcop_HeSF
https://drive.google.com/drive/folders/1Jf59BhsTCORgr_uC89w5FCmq9sxNvM9b?usp=sharing%20
https://drive.google.com/drive/folders/1Jf59BhsTCORgr_uC89w5FCmq9sxNvM9b?usp=sharing%20
https://www.loom.com/share/d420006085084fb0ab439619923187ee
https://drive.google.com/drive/folders/1qyRdo7095xAiEbV-bYutslS4XDgay9QV?usp=sharing%20
https://drive.google.com/drive/folders/1qyRdo7095xAiEbV-bYutslS4XDgay9QV?usp=sharing%20
https://www.loom.com/share/d420006085084fb0ab439619923187ee
https://drive.google.com/file/d/10t1sVpleHrUiiWYgsILMiaZQ90FOB_iS/view?usp=sharing

Understanding The Whole Course Building
Process

Designers should study both

1. The course-building process for the course-builders (reader of the Course Builder
Course) and the

2. The design process for the designers within the Design Guide.

That seems to be more sensible since the chapters that are relevant for a designer
within the Course Builder Course are spread out rather than compiled in one chapter.

In fact, even if these reasons are invalid, we still have to update the design guide
eventually for the Marketplace anyway
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Welcome to CoachYU Skinning Guide. This guide will help you in skinning, not just any
particular guide in CoachYu, but everything needed to jumpstart your agency or
company.

To give you a background on what we are currently doing. We have 60-70 plus guides
that we are presently maintaining, most of it averages into 100-200 plus pages. We also
categorized our design into three parts:

e Guide,

e Book, and

e Presentation version.

We usually provide the Indesign files for major guides made. However, for skinned
versions, we just do the fast and non-traditional way of doing it.

Skinned guides usually are the easiest thing to do; we just replace the cover, add
pictures, redo the paging, add a logo, and lastly, the conclusion page.

So let's get started.
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Opening PDF Using Multi-Pages Script

If we don't have an InDesign file for a particular guide, we don't have to worry as long as
we have the PDF. All we need to do is open up in Indesign. Then Locate the Window tab
> Utilities > Scripts

Then locate the “PlaceMultipagePDF" locate the PDF that you want to open.You can open
itin a “new document” or add it to a previous indesign file that you already opened. Click
Okay.

& Scripts

in Meon

Ras DathCHoarte

Fn PlaceMultipagePDF

S5 SelectObjects
Fn SortParagraphs

n spltstory

_—
Fn Tabutilites
il VEScript
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Editing the PDF

After doing the script, you now have a working PDF in the Indesign file, which you can add,
edit, and iterate.

In editing the PDF, you need to edit this using Adobe Illustrator. For example, on page
5 of a specific guide, you need to change the sentence or add an illustration.

You go to the main PDF and click open within Adobe illustrator. And input the page you
want to edit in the range section (see screenshot below). Once open you can now edit the
page then after just click save. Then update the link in Indesign.

1of119 b M

(of 119)

Qal

[] Import PDF pages as links for optimal performance
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Pagination and Master Page

Pagination is the most tricky part of skinning a guide. Since most of the PDFs already have
a permanent page in them. If you are that hardworking, you can edit each page and
change numbers. However, it will take you hours to do if you are going to change a
200-page PDF.

Here are the steps:
1. First, we replicate the bottom part of the guide using Adobe illustrator.

Delete the number

5

2. Then, group the replicated part and copy.
3. Open my Indesign file. Locate the Master file. Make a new layer. Then paste. (see
new page for screenshot)

*Untitled-2 @ 50% X

& Layers

v Layer 2
} <group=

v Layer 1

New Layer made

Background Tasks

Alerts

- ¢ Buttons and Forms

Name:  Button

l Pasted bottom from Illustrator l

On Relezse or T3
¢ Script Label
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4. You can then add a text. Type any number.
5. Then go to “type” > insert special character > Markers > Current page

LT
[ T T
Cists Ghia T
[=1F=1 Ap-Shi-Fi

Character Syles HPE-E11
Fasgraph Wie 1]
Cruaiw Ol wmun Ciri+ T+ O
Final Fami.

Eh-FI:J- ¥
Typz on p Sath [ —————
Fdanai P
rwcc o

st Fratrale

ieecu restyed Ftm oo Daptsaig .

Bocument Esdmobe Optigng.
Croneim Facen eng phd reinpts

Fhymarinks & Crras Paferenaas v |
Than® Vioof il b ’ '

Bl B Pirlarad Lim v |

vt Spaciad b ] Sembsk

et P Lpacs ' LT L] Caitrnrd Pags Flumber Ciste dde it W
ot Brmake Charscter ¥ Hyphans amd Dashm ¥ Feax® Puge bhomesar

Fill vt Planwhaiden Tat Casviaissn Rarks ¥ Pevvmis Page Hhamiser

Ot P et Mlmilimi

Fenencem bigrmiie

e bk Chaenter; il M1
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How To Convert A PDF To A PowerPoint

PERSONAL

\ DENNIS YU'S
. BRAND MANAGER [

N
WATCH THIS ﬂ »
FIRST q

\\\\&% *\ :3

=52 DENNIS Yu: RS

https://www.loom.com/share/Oc7d475ddfae4aef85a3c12feb796623
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How To Convert An Adobe Indesign File Or
PDF To A Powerpoint File

Click itle
: Click Subtitle

O H @ @ 9 & 3 ¥ x3 s @ @ « @ © B & ®xc A5 2 g

Convert An Adobe Indesign File Or PDF To A Powerpoint File (06:23)

COACHYU
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https://www.youtube.com/watch?v=ruRtBGc3JFg
https://www.youtube.com/watch?v=ruRtBGc3JFg

How To Update An Existing Guide Or
Presentation

1. Follow file naming convention.
a. “companyname_nameoftheguide_version_year_date

2. Upload the PDF to access@blitzmetrics.com
3. Update the Asset Tracker
a. Column for Guide Versions
b. Column for Presentation Version
4. Make sure that the PDF Guide and Presentation are “Viewable by anyone”.
5. Upload the Call To Actions (CTA) buttons to the first module.
a. CTA for Guide
b. CTA for Presentation

6. Hyperlink each CTA button with the corresponding file.
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How To Skin The Figurehead Pictures

If you are asked to skin a guide for a particular figurehead. We only need to gather the
following:

e High-resolution picture

e High authority picture

e Adobe Photoshop

Step 1: Open the high resolution picture into your Adobe Photoshop

BNK;

ll.
LS
.
2.
'
»,
2,
T
k.
0
P,
Q

[
a

‘aEpE

Step 2: Use the tracing tool
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Step 3: Trace the edges until you close it.

Step 4: Right-click the “Make selection”. Put Feather Radius as 1 then press okay.
Step 5: Inverse selection by clicking “Ctrl-Shift-1".
Step 6: Cut the background by clicking “Ctrl-X" Step 7: File save as a PNG.

Step 8: You can now edit the cover guide with your new cut figurehead picture
replacing Dennis.

Step 9: You can also make the high authority picture as your background image and
fade it accordingly.
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| think that is pretty much how we do our skinning the easiest and fastest way,
although there are other challenges and designs needed to make it really different

from the original.

This guide is particularly made for those people or designers who already have prior
experience and knowledge in Indesign. So we don't have to go deep on basic things. |

wish you best of luck and if you got any problems please do email me at
Jireh_naive@blitzmetrics.com
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Standard Last Page Design

e Grab high authority picture to be your background on the page

e If the client doesn’t have a vector logo or high definition PNG. You need to
retrace it in Adobe lllustrator to make it into a vectored logo which can be used
anywhere in the guide.

e Have a “Thank You!” message

e Have a high authority picture cut out for the client.

e Add a social media page button and email.
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SAMPLE LAST PAGE DESIGN

y ] ﬁumk

f (@getfound

= dennis@blitzmetrics.com
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How To Reskin A BlitzMetrics Google
Document To Coach Yu

When Reskinning BlitzMetrics Google Documents to Coach Yu, you must retain the
previous file such that at the end of your reskinning, you have 2 files—a BlitzMetrics
Google Document and a Coach Yu Google Document.

Estimated time to complete the task: 1.5 hours.

Ingredient Checklist
[J BlitzMetrics Google Document.
[J A Gmail account that has editing access to the Asset Tracker.

[J A Gmail account that is a Content Editor or Contributor to BM Assets &
Processes

Execution Checklist
1. Verify if the BlitzMetrics Google Document is in BM Assets & Processes or the
BlitzMetrics Drive.

a. Click the Move icon.

b. Click this icon to Open folder in a new tab. &

c. Next, determine if the file is within BM Assets & Processes or BlitzMetrics
Drive. IF the file is not located within the BM Assets & Processes or
BlitzMetrics Drive, THEN make a duplicate and place it in Unsorted.

2. Make a copy of the Google Document.
3. Place the document in the proper sub folder within BM Assets & Processes.

a. IF the BlitzMetrics Google Document is in BM Assets & Processes or the
BlitzMetrics Drive, THEN place the file in the same folder that the
BlitzMetrics Google Document is in.

b. Otherwise, place the file in Unsorted.

4. Rename the file by removing “Copy of “ and adding “ - Coach Yu” at the end.
5. Reskin the file.
6. Update the footer with the correct format and add the CoachYu Logo.

7. Place the URL of the file under column “Coachyu Converted Guide” in the Asset
Tracker's Guide Doc tab.

Verification Checklist
[0 The BlitzMetrics Google Document is unaltered.
O The Coach Yu Google Document is in a folder within the BlitzMetrics Drive.
[0 The URL ofthe Coach Yu Google Documenit is in the corresponding row for the
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https://docs.google.com/spreadsheets/d/1VPZRG7uEl3_3RCdaJrX3YFXeDqwRtDQXfFhcwuzQFbM/edit#gid=218932520
https://drive.google.com/drive/u/3/folders/1BccQ827YDrc1KZ3q99KNAtSxA_Uz1XMe
https://drive.google.com/drive/u/3/folders/1BccQ827YDrc1KZ3q99KNAtSxA_Uz1XMe
https://drive.google.com/drive/u/3/folders/1BccQ827YDrc1KZ3q99KNAtSxA_Uz1XMe
https://drive.google.com/drive/u/3/folders/0AGa8PhiAGGsxUk9PVA
https://drive.google.com/drive/u/3/folders/1BccQ827YDrc1KZ3q99KNAtSxA_Uz1XMe
https://drive.google.com/drive/u/3/folders/0AGa8PhiAGGsxUk9PVA
https://drive.google.com/drive/u/3/folders/0AGa8PhiAGGsxUk9PVA
https://drive.google.com/drive/u/3/folders/1BccQ827YDrc1KZ3q99KNAtSxA_Uz1XMe
https://drive.google.com/drive/u/3/folders/0AGa8PhiAGGsxUk9PVA
https://drive.google.com/drive/u/3/folders/1jZkKf3vt2IPcOdibL5Ig7A6FnRB9Kvdv
https://drive.google.com/drive/u/3/folders/1BccQ827YDrc1KZ3q99KNAtSxA_Uz1XMe
https://drive.google.com/drive/u/3/folders/1BccQ827YDrc1KZ3q99KNAtSxA_Uz1XMe
https://drive.google.com/drive/u/3/folders/0AGa8PhiAGGsxUk9PVA
https://drive.google.com/drive/u/3/folders/1jZkKf3vt2IPcOdibL5Ig7A6FnRB9Kvdv
https://docs.google.com/spreadsheets/d/1VPZRG7uEl3_3RCdaJrX3YFXeDqwRtDQXfFhcwuzQFbM/edit#gid=218932520

Tracker's Guide Doc tab.

Verification Checklist
[J The BlitzMetrics Google Document is unaltered.
[J The Coach Yu Google Document is in a folder within the BlitzMetrics Drive.
[J The URL of the Coach Yu Google Document is in the corresponding row for the
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How To Format The Footer Of A Master
Guide Google Document

1. Click Insert > Headers & Footers > Footers.

Footer |:| Different firstpage ~ Options -

2. Head to File > Page setup, then set the Bottom Margin to 1.

Page setup X

Apply to

Whole document ~
Orientation Margins (inches
® . Portrait Landscape Top 1

Paper size

Bottom 1
Letter (8.5"x11") =

Page color Left 1

Right 1

Set as default Cancel “

3. Set the Document name and page number. Set the alignment to Right Align (Ctrl +
Shift + R).

File format will be: “Document Name | page [n]”
e For guide name, it should be bold with the blue color of the logo: #2eb0e4
e For the word “page” it's italic.
e Where [n] is the current page number. To set the page number, after you
write the word “page” click on the Insert > Page Number > select the option
where the page will be set to the bottom right.
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Page numbers >

[
=+ Break -

o Link Cirl+K

Comment Ctrl+Alt+M

Bookmark

Table of contents - More options

Page count

4. Insert the CoachYu logo. Insert the logo anywhere in the Footer. To do this, click
Insert > Image > Upload from Computer. The logo is at CoachYu Logo.

5. Select the CoachYu logo, set the Format of the Image to Text Wrapping: Behind
Text.

To do this, click on the image. Head to Format > Image > Image Option. On the
right side, an option will appear. Select on Text Wrapping and set to Behind Text.

Adjust the image size to look like on the image below:

Footer Options =

-1 .
ICQAQH YlJ:: Design Style Guide | page 2

i B E OE Move with text ~

e Select the Options > Footer Format and mark the Different First Page. This is
intended for the Cover on the first page.

Note: Make sure the Document name and Page Number is set to 7.00 inches in the ruler guide
of the document.

r

i

-
Inl

7.00

&
|

ﬂ
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Most Common Mistakes Designers Make

1. The designer wrote the wrong file name.

The designer removed all hyperlinks to the succeeding iteration.
The designer spent too much time on the task.

The designer added unnecessary designs.

The designer did not use an existing template.

AN A

The designer encountered an upload glitch and decided to not upload at all, instead
of looking for alternatives to share the file.

~

The designer uploaded the file to their own personal drive.

8. The designer uploaded only the PDF file without the project files, e.g. Adobe
InDesign file and the images.

9. The designer did not iterate on the existing Basecamp Thread, or To-do; or chose
not to create a Basecamp Thread or To-do.

10.The designer sent a message on Basecamp while not following #RACI (Responsible,
Accountable, Consulted, Informed).

CQACHYU Design Style Guide | page 53



TEST QUESTIONS

1. What are the main software used in skinning guides?

2. How do you open a multi-page pdf in Indesign?

3. How do you fix the problem with page numbers?

4. In tracing a figure head what software do you use?

5.  When you “make selection” what radius should you use when you
feather?
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Designer Skill Assessment

Task 1. Remake this exact image in Adobe InDesign. ReMAKE, not re-design.

Master Master
Presentation
Skinned MINI

Project files:

BUSINESS
PACKAGES

TUDENT
AINING

PARTMER
PROCESS

EE=a-000000 A
Sl ==8-000000 -
Training System
Guid'

[ o R13[12]15 161715 . v ‘
< ap:mm Busmus.
Strategy

M m

The 9 Triangles Framework

Specialist

Partner  d——  Business

o’ . Leadership, 4 Word of 4
/ N\ X / \ Ay / /
/e, / Y / /]
Ef \ Y/ \
9 triangles comprise the mega Framework of Business triangle

18 module Diagram 9 Triangle

chirorevenue ops training diagram1 v1.2 2021 0120

explode

Results:
1 PDF.

1 Adobe InDesign Project file.

COACHYU
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OPSQUEUE  CLIENT QUEVE °

1. Clean up this image into something more like our branded look—image in task
1.

2. Make everything symmetrical.

3. Change the numbers to all be the same color and fonts to the same fonts you're
using.

4. Make the colors of the numbers with circles and the pink boxes white.

Project files:
18 module Diagram 9 Triangle
chirorevenue ops training diagram1 v1.2 2021 0120

explode

Results:
1 PDF.
1 Adobe InDesign Project file.
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Anatomy of a Template

Anatomy of a template

Each of the templates here are made in Photoshop CC and should be compatible with Photoshop
CS6. They have been configured to the standard resolution of the most popular social media, as
well as print media for events.

In the layers panel, you will find that there are 3 main groups of layers. These are: Text, Speaker
Image, and Background. All of which may be customized as needed.

BANN
N

SPEAKER IMAGE

LAYER

BACKGROUND

LAYER

FOUR
LINE
SUBJECT
TITLE

MONTH 00

(O0AM EST 00 PM PST
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Text Layer

This is the top-most layer where you include the
details of what the image is meant to convey, e.g.
event title, time, date, venue, speaker or guests
name, etc. Font, font size and spacing may vary
depending on the intention of the design.

However, when using the image as a Facebook Ad,

one needs to adhere to the 20% text to image rule. - Weh layo...x 312px
This rule will be discussed later under Facebook
Ads. - Mabile ... x 360px

For CoachYu, the font used is Bebas Neue

which can be downloaded here. This can be
substituted by any font that adheres to your brand
guidelines.

T Uate and lime

T Couble lin...ect tide

~ [ Spezker Image

‘ " Speaker ...Option 1
Two options for speaker images are presented =
here. Though you can make your own, these have m Speake..fion2 X -
been presented to save time. N

Speaker Image Layer

{3 Effects
Each layer is presented as a smart object. Double © Stroke
click on the smart object icon to replace customize “ [aa Background
the image with your own. This will open another = e
layered file embedded in the PSD file. Copy the
image you need want to include and position BRI o\ rou... Option
accordingly. :

Backgrou...radient
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- Web layo...x 312px

Mabile ... x 360px

T Late and lime

T Double lin...ect tide

~ [l Speaker Image

‘;.] Speaker ...Option 1
t!: Speake..tion 2 X

{3 Effects
> Stroke

~ mal Background

» ]l Elitz Stripe

|| |
!:: ?.;I Backgrou... Option

Ijl Backgrou...radient

COACHYU

Background Layer

This group layer is composed of your logo, an
optional background overlay and a background
gradient. All these may be adjusted according to
your brand design guidelines.

Guides Layer

These are often turned off and may not be included
in all the templates. This layer helps illustrate
important notes to aid the designer in putting
together with a layout.

Smart Objects

All templates have layers with smart objects. In

order to change the content simply double click
on the smart object icon and replace the image
with the one you prefer.

Guides

Guides are lines that can be seen in production
but not in the final image. These help designate
areas in the image and aid in producing the layout.
If you do not see the guides, simply toggle Ctrl +;
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Social Media Templates

Social Media Templates

All the templates provided here cover the most commonly used formats for still images used in
Social Media.
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Facebook

Cover Photos
The tricky thing about putting this together is that the image must work well on both web and
mobile. The solution is to put together a layout that works on both.

Turn on the visibility on the “Guides” layer to have an idea of how this works in your layout.

Technical specifications

Full image dimensions: 820 px x 360 px
Mobile layout dimensions: 640 px x 360 px
Web layout dimensions: 820 px x 312 px

Template

DOUBLE LINE
SUBJECT TITLE

MONTH 00 | OOAM EST 00 PM PST

-
COACH r =

BlitzMetrics
@BlitzMetrics

1k Like | X\ Follow = Shar

Images for News Feed

These images are for posting on the News Feed that do not need to be promoted. These are
generally in the form of quotes. Though there are 2 options you can choose from to make a post
like this, it is recommended that the mobile-friendly, square 1080 px 1080 px format be followed.
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This format takes into consideration that most people view Facebook on their mobile devices.
These are also the same dimensions for Instagram posts.

Technical specifications
e Square image dimension: 1080 px x 1080 px
e Template
e Rectangle image dimension: 1200 px x 628 px
e Template

BlitzMetrics
@BlitzMetrics

Home
Posts.
Reviews 1 Like | X\ Follow | A Shars | - (® Send Message

Videos

Photos
About

[ Osmiieme |
LDS Business College
Community
Events
Welcome e
=T
|

“LOREM [PSUM DOLOR SIT AMET,
CONSECTETUR ADIPISCING ELIT,
SED DO EIUSMOD TEMPOR
INCIDIDUNT"

-NAME | DESIGNATION | COMPANY

COACH

Images for ads

Facebook requires that text on ads be, at the most, 20% of the image. Finding out if your text is
20% of an image is quite challenging. First thing to do is to place a 5x5 grid on the image. If the text
on the layout occupies 6 areas on the grid then it's within 20%. Now, this is a hack and not a rule,
but it has proven to be accurate most of the time.

Examples of the 6 areas on the 5x5 grid are shown below:
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Toggle the guides on the template by pressing Ctrl +;

NE
SUBJECT

TMLE

MONTH 00
OOAM EST 00 PM PST

COACH

As a final step, make sure to use the Facebook text overlay tool here.

Technical specifications
e Square image dimension: 1080 px x 1080 px

Template
e Rectangle image dimension: 1200 px x 628 px

Template
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FOUR
LINE
SUBJECT
TITLE

MONTH 00
OOAM EST 00 PM PST

COACH

DOUBLE LINE
SUBJECT TITLE

MONTH 00
OOAM EST 00 PM PST

COACH

Instagram
Instagram Ads and News Feed posts generally follow the same technical specifications as

Facebook except for the addition of Instagram stories.

Instagram Stories, has a vertical orientation and takes up the whole screen of the phone. The
layout has been put together to give some allowance to the Instagram User Interface. Feel free to
toggle the “Guides” layer to find out how this comes out in the layout.

Another difference is that the 20% text rule doesn't apply here.

Technical specifications
e Square image dimension: 1080 px x 1080 px
Template
° Recta&e image dimension: 1200 px x 628 px

COACHY
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Template
e Instagram Stories Dimensions: 1080 px x 1920 px

Template

“LOREM IPSUM EA
DOLOR SIT AMET, |9

“LOREM IPSUM CONSECTETUR =

DOLOR SIT AMET ADIPISCING ELIT, SED //f

DO EIUSMOD TEMPOR” Shg_s,.
CONSECTETUR INCIDIDUNT” =

ADlPlSClNG EI‘IT’ SED - NAME | DESIGNATION | GOMPANY
DO EIUSMOD TEMPOR e
INCIDIDUNT"

- NAME | DESIGNATION | COMPANY

“LOREM IPSUM
DOLOR SIT AMET,
CONSECTETUR
ADIPISCING ELIT, SED
DO EIUSMOD TEMPOR
INCIDIDUNT"

- NAME | DESIGNATION | COMPANY
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LinkedIn
LinkedIn helps you reach out to audiences catered towards the more professional market. Topics

usually range from career advice to business insights and professional development. When
putting together a composition it's important to put together a layout that's relatable to your
audience. Like Instagram Ads and News Feed posts, the 20% text rule does not apply here.

Technical specifications
e Rectangle image dimension: 1200 px x 628 px

e Template
“ CoachYu
nternet - Albany, CA -788 followers

Build your Facebook ads agency with our training and implementation! Become a
certified digital marketing specialist.

v Following Visit website See all 56 employees on Li
I Home @ Images Documents Videos Sort by: Top w
About CoachYu
R 757 followsrs
Jobs 2yr+ @ Anyone
Want to know the #1 question we get asked all the time?
People

How to create @ Facebook strategy and then measure 't

& Like [E] Comment 2> Share

DOUBLE LINE
SUBJECT TITLE

MONTH 00
OOAM EST 00 PM PST

COACH

CQACHYU Design Style Guide | page 66


https://drive.google.com/file/d/1JqbErXdBubZDO9y49l854H0PYinO9YsP/view

Event Templates

Event Templates
There may be times when, as participants or hosts in conferences or a summit, we may need to

put together physical banners at the venue. Putting together digital assets for printing is quite
different from those that are viewed on the screen.

In terms of the layout, one must always be aware of the distance of the banner from the viewers,
as well as if the main point of focus is within eye level.

Another thing to consider is the pixel density. Printed

material is often at a higher density than material that shows
up on screens. Printing for banners located in events COACH are
generally set at around a density of 150 ppi/dpi.
Technical specifications FUUR
e Standee Banner Size: 6'x 2’
Template I_INE
e Event Banner Size: 2'x 8 SUBJECT
Template TlTl_E

MONTH 00
OOAM EST 00 PM PST
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Video Billboard Templates
Video Billboard Templates

Video Billboard Templates are still images that are usually flashed on the screen to introduce and

highlight the guest speaker. These can either be used as a slide on the show or as part of the set
background when in a broadcast.

Technical specifications
e Image dimensions: 1920 px x 1080 px
Template

SUBJECT
SPEAKER NAME

DESIGNATION
COMPANY

COACH

COACHYU
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Graphic Templates

Graphic Templates
These layouts are meant to serve as guides. We've provided a few other graphic templates below
which you can mix and match with the templates above to give you more variety.

Other resources

We've provided you with the list of templates above to make things run a bit faster. However, if
you choose to be a bit more adventurous feel free to jump in and check out the following
resources.

e Facebook Creative Hub - your complete guide to ads on Facebook;
https://www.facebook.com/business/inspiration/creativehub

e Instagram Business - a comprehensive guide to Instagram ads and marketing;
https://business.instagram.com/

e Adobe Spark - a completely free online software that helps you compose images;
https://spark.adobe.com/

e Canva - a drag-and-drop online design software, also free; https://www.canva.com/
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How To Prepare A Presentation Deck

The more presentations you see me give, the more you'll notice that | tell a
story, teach from that example, then extrapolate to the bigger picture. Then | repeat
again, starting with another specific story.

Contrast that with showing just tips, which comes off as professorial, and you'll see
why we tell stories to teach. In fact, it's why we are constantly teaching people how to
do a WHY video (when | was, | believe that, | am)-- we are literally following this
framework thousands of times.

Now that you know this, consider how to adjust these decks to fit the style I've used for
years. Part of the reason | use this presentation style is to be able to speak when there
aren't any slides or when the slides aren't usable. Of course, we prefer having usable
slides instead of forcing me to open tabs to narrate (as you typically see me do
hundreds of times in the last few years).

Note also that the presentation version is
for me to present (I'm narrating, so we don't
want lots of text) and we hand out a guide
version (a "book" that people can read later
at their leisure, not narrated verbally by me,
but with text to read). The good news is that
the guide versions are just re-skinned
versions of what already exist. You'll see
that what we want to present here is 95%
the same as the base presentation I've been
doing for years-- mainly just skinned and
narrated differently.

At both the beginning and end of a
presentation, we want to list the key points
as bullets-- especially again at the end, so
we can recap. Most attendees won't
remember the particular tips, so they will
feel lost without a "Top 10" list. So be sure
to not only do this here, but make sure we
put it in our Course Builder Course, so
others will know, too.

CQACHYU Design Style Guide | page 70



The more presentations you see me give, the more you'll notice that I tell a story, teach
from that example, then extrapolate to the bigger picture. Then | repeat again, starting

with another specific story.

MARSHALL

GREATEST

Contrast that with showing just tips, which comes off as professorial, and you'll see
why we tell stories to teach. In fact, it's why we are constantly teaching people how to
do a WHY video (when | was, | believe that, | am)-- we are literally following this
framework thousands of times.
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LIVE PRESENTATIONS FOR ONE MINUTE REHEARSALS OF
YOUR WHY

Now that you know this, consider how to adjust these decks to fit the style I've used for
years. Part of the reason | use this presentation style is to be able to speak when there
aren't any slides or when the slides aren't usable.

Of course, we prefer having usable slides instead of forcing me to open tabs to narrate
(as you typically see me do hundreds of times in the last few years).

SOCIALIMEDIA
MARKETING
WORLD

THE ULTIMATE
FACEBOOK ™

WHAT MODERN MARKETERS AD LOCAL PLAYBOOK
NEED TO KNOW ABOUT - s
FACEBOOK'S ALGORITHM IN ¥

2020

BRENNAN
AGRAMNOFF

CEQ AND FOUNDER
HOQPEWALT

Dennis Yu

CEQC and Founder
hlitzmetrirs
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From Smart Traffic Presentation to Social Media Marketing World using the same deck.
Note also that the presentation version is for me to present (I'm narrating, so we don't
want lots of text) and we hand out a guide version (a "book" that people can read later at
their leisure, not narrated verbally by me, but with text to read).

The good news is that the guide versions are just re-skinned versions of what already
exist. You'll see that what we want to present here is 95% the same as the base
presentation I've been doing for years-- mainly just skinned and narrated differently.

COACHYU

DENNIS YU

& OIGITALMARKETER

HOW TO GENERATE 1,000

PIECES OF CONTENT

FROM A SINGLE VIDEO
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VIDEO THUMBNAILS

e Make sure the play button is centered perfectly within the thumbnail.
e Include the video title at the bottom-right of the thumbnail in bold.
e Include the run-length of the video after the title in standard font (not bold).

IMAGE DESCRIPTIONS

e Inthe case of replaced images or career changes, make sure the images
descriptions are up to date and accurate.

e With very few exceptions to this, format all image descriptions like so:FirstName
LastName (position in image), Title | Company

QUOTES

e Always include the quoted person’s headshot before his or her quote is
introduced.

e Italicize quotes

e Most of the time, quotes should be a lighter color than the body text, typically
gray.

e Never forget the open and end quotation marks.

CQACH Design Style Guide | page 74



WE DON'T WANT EVERY LEVEL 1- 2 VAS WORK TO MUST GO THROUGH QA BY
THEIR TEAM LEAD, FOR TWO REASONS:

e QA work creates bottlenecks and slows down the deliverables although
sometimes necessary.

e We should be able to rely on our trained team members to deliver results to our
expectations without going through QA by Team Lead.

But when we see a trend of poor workmanship from the team members, the business
leaders and myself may ask that the work goes through QA by the Team Lead
temporarily. This brings back some accountability to the Team Lead to re-train or let go
of the team member.
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Submit a small summary and your answers to the test questions and get these badges.
Email us at operations@blitzmetrics.com

COUACH

DESIGNFR

CUACH

SKINNED GUIDE
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